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1 Overview

SILENSe (Simulator of Light Emitters based on Nitride Semiconductors) is a specialized
software tool for modeling the characteristics of light emitting diodes (LEDs) made of wurtzite
semiconductor materials. The software allows simulation of an LED band diagram as a
function of bias, electron and hole transport inside the structure, radiative and non-radiative
carrier recombination, light emission efficiency, electric field distribution, and emission
spectra from the LED. The software implements a one-dimensional drift-diffusion model with
account for specific features of the nitride materials — strong piezoeffect, existence of
spontaneous electric polarization, low efficiency of acceptor activation, and high threading
dislocation density in the structure. The software enables the analysis of graded-
composition heterostructures, which is important for designing LED structures of a new

generation on the basis of bandgap engineering principles.

Laser Edition of the package also enables computation of the waveguide modes and

prediction of the threshold characteristics.

Advanced numerical algorithms are employed in the solver in order to make the software
more effective and robust. In particular, the mixed finite-elements method is implemented in
the program to solve the nonlinear carrier transport equations coupled with the Poisson

equation for the electric potential in a complex multilayer LED structure.

The code has an easy-to-learn graphical user interface (hereafter, referred to as the shell)
assisting the user in preparation of the input data, carrying out simulations, and results
visualization. All the results can also be exported in ASCII files and explored within an

external visualizer like Microcal Origin®, Tecplot®, Golden Software Grapher®, etc.

1.1 SIiLENSe Options

The current version of SILENSe package provides the user with the following options:

» Calculation of the band diagram, current, internal quantum efficiency etc. for a given
bias. One can also set up series computations to cover some range of the bias
variation.

» Calculation of the carrier wave functions, and the emission and gain spectra from the

known band diagram.
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» Plot an integral characteristics of the LED operation for all the computed biases, such

as |-V curves etc.

The following options are available in Laser Edition only:
» Computation and visualization of the waveguide mode intensity distribution for both
TE and TM polarizations with account for the birefringence in wurtzite crystals.
Computation of the optical confinement factors.
» Analysis of the laser diode operation for selected waveguide mode:
1. Optical gain.
2. Optical losses caused by the free carrier absorption.
3. Threshold current and differential quantum efficiency.

2 Installation and Registration

2.1 Installation

To install the SILENSe , run the installation executable file and follow the installer
instructions. To uninstall the program, run the uni ns000. exe file in the program home
directory or use the respective item in the Programs menu.

NB The software needs write permission for its home directory!

The software is supplied with license protection system based on dongle key which is a

small USB device. During installation, the user is prompted to install the dongle key driver.

2.2 Single node license

The user can install the program on several PCs (for example, on the desktop and notebook)
and run the program on the PC where the dongle key is plugged in. The registration
procedure is as follows:
» Plug in the dongle key module.
> Start the license manager (Li cense. exe) located the SiLENSe home directory.
One can also do it by Windows Start button.
» Choose the Key config tab and press the Make Key button. The request file (*.req)
containing the information about the dongle will be generated.

» Send the generated request file to STR by e-mail simuled-support@str-soft.com .

» When the reply from STR is received, plug in the dongle, start the license manager,
press Accept Key button, and browse fro the license file (*.lic) received from STR.

» Now one can run SiLENSe.
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2.3 Corporate/department network license

Corporate/department license allows the user to run the software on several
computers within the local area network (LAN). The software may be installed on any
computer of the network, but the maximum number of running copies of the software is
limited by a certain number, e.g. 10, specified in the particular license agreement (quotation,
purchase order, etc.).

Hereafter, by the ‘server’ we will understand the computer where the USB dongle key
is plugged in. The user should install the dongle key driver on this PC. A special tool
server. exe called below ‘license server’ to be running on the server computer. After
start, the respective icon appears in the system tray. The pop-up menu allows one to restore
the window and inspect the event log or the license server. The Change Port button allows
the user choose the port number for communication between the software running on other
PCs and the license server.

To obtain/update the license, on need run the Li cense. exe file on the server PC.
Further procedure is similar to that described in Sec. 2.2 .

All the PCs running the SILENSe software we will call ‘workstations’. Running the
software on the server computer is also allowed. Installation of the software on the
workstations is described in Sec. 2.1. The user need not install the dongle key driver on
workstations. On the contrary, one should run the Li cense. exe file, choose Server config
tab, and specify the IP address of the server PC and the port number. The Store button
saves this information in the Str_Confi g_SL. cf g file in the software home directory.
This file is used by the software to communicate with the license server. The Remove button
clears the file. The Test button allows one to test the communication with the license server.
NB The following conditions to be fulfilled for running the software on a certain workstation:
(i) the dongle key to be plugged into the server PC, (ii) license server to be running on the
server PC, and (iii) the workstation is able to communicate with the license server by the IP
address and port number specified in the St r _Confi g_SL. cf g file in the software home
directory.

NB Unplugging the dongle key from the server PC or stopping the license server will result in

abnormal termination of all the running software copies!

3 Getting Started

SILENSe project files have *. sl s extension and store the following information:

» LED heterostructure
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» Global physical and solver parameters

» Properties of the materials used in the heterostructure

» Simulation results

Warning: The package is designed in such a way that all the simulation results stored in the
project file are always self-consistent with the input data. So the user can not modify the
heterostructure and some global parameters like the temperature if there are some results
stored (see description of the Tools->Unlock Project menu item).

3.1 Materials Properties

There is a special Properties Editor in the SILENSe package for editing the materials
properties. It provides a unified way to set up the material properties of binary semiconductor
compounds and their alloys. The material properties are saved in the special project file of
the Properties Editor (*. mat prop). All the computational modules of the SiLENSe
package load material properties from these files. The detailed description of the Properties
Editor is given in [1]. Below we give a short description of the Properties Editor in respect
to the SILENSe. Generally, the materials in the Properties Editor are divided into two types:
(i) materials of fixed chemical composition, like GaN, GaAs, ZnO, etc. and (ii) alloys with

variable composition, like Alln,Ga;.«yN, Zn;,Mg,O, AliGa,..As, etc.

The default database of the material properties is supplied with the SILENSe package, but
the user can as modify the material properties as well as add new materials and alloys.

Creating a new SiLENSe project file, one should specify the Properties Editor project file
from which the material properties will be loaded. The SiLENSe project file can include the
layers made of the described materials and alloys. In the Material properties tab window, the
loaded values are shown in the read-only mode, but one can use Material Properties -> Edit
menu item to change the date. Justification of the choice of the materials constants used in
the SILENSe by default is given in [1].

3.2 Heterostructure

A LED heterostructure is described as a sequence of layers. The user should specify the
composition, doping and thickness of each layer. The growth direction is assumed to go from

the first layer to the last one. However, this assumption does not limit the software capability
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because the user can choose the appropriate crystal orientation in the Heterostructure tab

window.

NB: The first layer appearing in the ‘Heterostructure’ list is thick n-type contact layer (usually

GaN). The user need not input nucleation and buffer layers!

3.3 Global Parameters

In the Global parameters tab window, the user can specify some global physical parameters,
such as LED operating temperature and some internal solver parameters controlling the
numerical computations. The parameters related to analysis of laser diodes are shown in the
Laser parameters tab window. A default set of the parameters is loaded automatically in a

new project. The solver parameters are discussed in details in Sec. 5.6.

3.4 Running the Calculations

Most of the calculations can be started from the Run menu. Some of the Run menu items
are duplicated by the respective buttons in the toolbar and/or hot keys. The menu item ‘Stop’
allows the user to abort current calculation. The calculation of the emission spectrum and |-V
curve to be started from the LED Results and PL Results windows. One can open them by

the respective items in Window menu or by the respective button in the toolbar.

3.4.1 Band Diagram and Carrier Fluxes

To start single calculation of the LED band diagram, use the Single Calculation menu item.
The modal window appears where you will be prompted to enter the bias and start the
computations. The Calculation window appears where the iterative solution process is
described. The user can abort the computations by the Stop button. When the calculations
are complete, the simulation results are shown in the Results tab window containing several

plots. To switch between the plots, use the vertical tabs along the left side of the plots.

Series calculation menu item allows calculations for a number of bias values at once. The
modal window appears with the list of biases which will be processed. The user can add a
single bias by the Add button, while the Add sequence button enables one to add a
sequence of biases varying from a Start bias to the End bias with a given Number of
intervals. The entered biases can be edited or deleted by the buttons Edit and Delete,

respectively. Use the button Delete All to clear the list.
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Series calculation for SpeCLED menu item allows automatic computations for a given range

of the p-n junction bias and the temperature. List of biases is specified exactly as for series

calculations, and the temperature list is specified in a similar way.

3.4.2 Carrier Wave Functions, and Emission and Gain Spectra

The carrier wave functions, and the emission and gain spectra are calculated from the
already known band diagram. To start the calculation, one should open the LED Results
window, select the desired bias, and use the Run | Wave functions and spectrum menu item
or the respective button. The results are displayed in the Spectrum tab window containing

two tabs with plots, Band diagram and wave function and Spectrum.

The list of individual quantum wells appears on the right of the former plot. An individual
guantum well can be selected in the graph by the vertical cyan stripe initially located in the
first quantum well. This stripe can be moved from one well to another either by choice of the
well number with the mouse in the quantum well list or by pressing the keys “- ", “<”, “17,

and “1” on the keyboard.

The list of the localized state energies of the carrier in the selected quantum well is given in
the mini-windows on the right of the quantum wells list. To show/hide the wave functions in
the main graph, use the check boxes in the mini-windows Electrons, Heavy holes, Light

holes, and Split-off holes, where the energies of the respective energy states are indicated.

The Spectrum plot shows the emission and gain spectra of individual quantum wells, as well
as the total spectra. The user can switch the values of X-axis between the quant energy and

the wavelength by the respective tab.

3.4.3 |-V Characteristic and Internal Quantum Efficiency

To get the I-V curve, one should open the LED Results window, select the desired biases,
and use the Show | |-V Characteristic menu item or the respective button. The modal
window appears with three plots. The former two plots represent the current density as a
function of the bias and the internal quantum efficiency variation with the current density,
respectively. The last plot is introduced to rely the calculated current density with
experimentally observed |-V characteristics by qualitative accounting for the series and

contact resistance. The user is prompted to specify the LED area, the series resistance, and
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the contact resistance for the n- and p-contacts. The current and voltage are calculated as
described in Sec. 7 of [2].

3.4.4 Waveguide Modes

To compute the electric/magnetic filed distribution of the waveguide modes, use the Run |
Waveguide Modes menu item. The modal window appears where you will be prompted to
enter the light wavelength. When calculations are complete, the results are shown in the

Waveguide tab window.

3.4.5 Laser Characteristics

To simulate operation of edge-emitting laser diodes, a number of additional parameters to be
specified in the Laser parameters tab window: cavity dimensions, mirror reflectivity,
polarization (TE/TM) and index of the mode (here one should choose the mode with highest
optical confinement factor, which will reach the threshold first).

Run -> Single Calculation With Laser and Run -> Series Calculation With Laser menu items
allows running simulations at specified bias (list of biases) with self-consistent account of
stimulated recombination in the active region (the details are given in [2], Sec. ‘Laser
Characteristics’). Simulations will look similar to LED calculations, while results are stored
into Window -> Laser Results and Window -> Laser Characteristics windows.

Run -> Laser Characteristics (Old) menu item allows to run old laser model to compute the
threshold current without self-consistent account of the stimulated recombination. The
program will seek for the threshold performing calculation of the gain and loss for each bias
and comparing them. The user can see the computation progress in the progress bar and
stop calculations by the Stop button. Results are stored into Window -> Laser

Characteristics window.

3.4.6 PL simulations

PL simulations be started by Run menu items Run PL and Run PL Series. User needs
specify the excitation power density. PL simulations are stored in Window -> PL Results
window and handled similar to simulations of the band diagram at the given bias. To get PL
emission spectrum, one needs open list of PL results by using Window -> PL Results menu
item, select the results for desired excitation power, and start simulation of the emission

spectrum as described in Sec. 3.4.2.
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3.5 How to Load, Export, and Delete the Simulation Results

The project file contains some simulation results related to the project. The Window | LED
Results menu item or the respective button opens the LED Results window with the table of
the results which were stored in the project file or computed during the current session. The
table includes an integral data like the bias, current, internal quantum efficiency etc. To load
a result in the Results tab window, one should choose the result by single mouse click and
use the Show | Current result menu item or the respective button. A double-click on the
respective string has the same effect. One can use the Edit | Delete selected menu item or
the respective button to delete results selected by the checkboxes in the left column.

The Export menu allows one to save the current result or the 1-V curve in an ASCII file. The
output formats are described in details in Sec.5.

3.5.1 Export Simulation Results to SpeCLED Module

The user can export simulation results to the SpeCLED module for further 3D analysis of
current spreading and temperature distribution in the LED chip. One should check simulation
results in the LED Results window and use the Export to SpeCLED menu item or the
respective button. An Export to SpeCLED modal window appears with list of selected
voltages. The user should start computation of emission spectrum by the Run spectra
button. The status of spectra computation is displayed in the table. When spectrum
computations are completed one can finish export by the Export button.

Warning: The data for SpeCLED module should cover the whole IV range. The voltage step
should be not greater than 0.1 V for voltages higher than a turn-off voltage. For a minor

current under low biases a larger step of ~0.5 V is acceptable.

4 Graphical User Interface

The chapter describes the user’s options available to control the data input, simulation of
LED characteristics, and visualization of the simulation results within the Graphical User
Interface (GUI). The SILENSe is provided with the interactive shell designed for easy-to-
learn specifying the input data, such as thickness, composition, and doping of each layer of
a LED heterostructure, and for setting the computation parameters. The shell also provides
an interactive control of computations as well as visualization of the results. The start
window of the SILENSe shell contains Menu, Toolbar and the title of the software tool in the

center of the window.
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4.1 Menu and Toolbar

The Menu contains the File, Heterostructure, Material properties, Run, Export, Tools,
Window, and Help items. The File menu allows one to create new project, open an existing
project, save changes in the current project file, and exit the shell.

Import material properties to new project

—Select datab file :
|C.\Prugram FileshSTR InchSILENSe 4.0 Laser Edition®defaultDB . mat

B BrOwWSe

List of alloys
+" AlinGal
" MgZno

List of
+ AN
+ InH
+" GaH
+" Zn0
«" MgQ

+" Sapphire
+" SiC-6H
" SIC-4H

+" OK | ¥ Cancel |

Fig. 1. Load material properties to the new project.

The menu item New is for creating new project. The modal window will appear where the
user will be asked for the Properties Editor file with the material properties (3.1). The
window also contains the lists of materials and alloys described in the selected file. The
green tick and the red cross show if the respective item contains all the properties necessary

for calculations.

The Heterostructure menu contains different operation with the heterostructure layers. All

these actions are duplicated y the respective buttons in the Heterostructure tab window.

The Material properties menu allows the user to export the data from the current project to
the separate material database file, overload the existent data from other SiLENSe project
or material database file (import of the material properties), and open Properties Editor to

edit the current dataset.

The Run | Single computation menu item starts single computation. The modal window
appears where the user is prompted to input the bias. The Run | Series computations menu
item allows one to perform a set of calculations for a number of bias values. The modal

window appears with the list of biases which will be processed. The user can add a single
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bias by the Add button, while the Add sequence button enables one to add a sequence of
biases varying from the Start bias to the End bias with a given Number of intervals. The

entered biases can be edited or deleted by the buttons Edit and Delete, respectively. Use
the button Delete All to clear the list.

-0l =l |+ Series Calculation for SpeCLED 1Ol x|
 Bias [¥)  Bias [¥) Tempearture (K)
2.500 4' 300.000 4'
2.600 o 310.000 e
2.700 - 320.000 _
2.800 B Edit | 330,000 B Edit |
2.900 : : =1/ 340.000
3.000 . 5| | 350.000 *; Add Seq"encel
3.050 360.000
2.100 370.000
2.150 ] 380.000
3500 _ xpeee [| 3 _ xeete [|I260:000 _ xpeete |
3200 % Delete All | 320 % Delete All | 400.000 % Delete All |
3.350 2250 =
3.400
3.450 [~ Save intermediate SILENSe files [* 5lz] with results for each temperature
3.500
[* Run | X Cancel | [* Run | X Cancel |

Fig. 2. Series calculations modal window (left) and series calculation for SpeCLED (right).

Series calculation for SpeCLED menu item allows automatic computations for a given range
of the p-n junction bias and the temperature. List of biases is specified exactly as for series
calculations, and the temperature list is specified in a similar way. Data for SpeCLED (*.sct
files) are generated automatically, and SILENSe files (*.sls) with complete results are

optionally saved for all temperatures.
During the computations, the bias values are indicated by colored rectangles. Grey color
means that the calculation for the task has not been started, blue color marks the current

task, successfully finished and failed tasks are shown by green and red colors, respectively.

The Waveguide Modes item of the Run menu allow one to start the computation of the

waveguide modes.

The Single Calculation With Laser and Series Calculation With Laser items of the Run menu

allow one to start simulation of the laser operation at the specified bias (or series of biases).

The Run PL and Run PL Series items of the Run menu allow one to start simulation of
resonant PL experiment at the specified excitation power density (or for several powers).

The Stop item of the Run menu allows the user to abort current calculations.
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Some of the Run menu items are duplicated by the respective buttons in the toolbar and/or
hot keys.

NB The calculation of the emission spectrum and |-V curve to be started form the LED

Results window.

The Export menu enables one to save computed result to ACSII file. The band diagram for a
certain bias or the I-V curve to be exported from the LED Results window. Save current chart

item allows the user to save current chart as a graphic file.

The Tool | Unlock Project menu item and the respective button in the toolbar are enabled
only if there are some results computed during the current session or previously saved in the
project file. Then the user can not modify the heterostructure and global physical
parameters. This limitation is introduced to make sure that the input data and the simulation
results are self-consistent. Use this item or the respective button to delete all the results and
enable modification of the heterostructure and global physical parameters. The confirmation
dialog appears with warning that all results will be deleted. To keep the results, the user
should (i) save the project to store the result obtained in the current session, (ii) save the
project under a new name, and (iii) unlock the project and modify it.

The Tool | View Iterations menu item and the respective button in the toolbar allow one to
inspect the iterative solution process. When this option is turned on, the plots in the Results

tab window are updated after each iteration. However, it makes computations slower.
The Window menu is to open additional windows with solver log and auxiliary simulation
results. The most important is the LED Results window containing a table of processed

biases and some integral data like current density, internal quantum efficiency, etc.

The Help menu includes the About option providing the user with brief information on the
SiLENSe.

The toolbar contains buttons for a quick access to the main options.
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4.2 Tabs of the Main Window

4.2.1 Heterostructure

The Heterostructure tab window allows the user to specify the LED heterostructure
considered to be a sequence of semiconductor layers (Fig. 3). To manage layers, one can
use the Heterostructure menu items or buttons from the vertical toolbar in the left part of the
tab. Use Add Layer, Delete Layer, Edit Layer, Move Layer Up, and Move Layer Down to
create, delete, and move the layers. One can copy the selected layer into a buffer and insert
the layer from the buffer after the selected layer by the buttons Copy Layer and Insert Layer,

SILENSe 5.2 Laser Edition s 4 ] |
File Heterostructure Material properties Run  Export Tools Window Help
e w|o| 2| e|os]
H | i ies | Results | Spectium | Laser Wavequi
Layers : | Curent layer
N Name Thickness. nm Type I Composilion
Fraction Left Right Middle
InGiaN-aw a AllnGaN AN 0
Q reliaN-barier 12 AllnfzaN Ik g
4 iGN 3 AllnGaN Gall 1
g8 poblGal 50 AllnGaN
= 5 BE =i G Dopant concentration (cm™-3)
@ Dopant Left Right Middle
Donars 2.000E+18
Q Aeceplors i
[Strain in the first layer -
Q gl Drientation [0001] (Ga-polar) -
" First layer is strained
Q Inclination angle (degree): |u

Daping |Muhilily Relanation | Dislocation density | Lifetimes | DOS tails

[v| Donors [1/em™3]
[v] Acceptors [1/em™3])

0 500.0 503.0 5150 5180 5300 5330 5450 548.0 608.0 1108,

e —————————————————————————————————

Fig. 3. Heterostructure tab window.

When the user clicks the Add Layer button, the pop-up menu appears where the material
type should be chosen from the lists of available materials and alloys. The Edit Layer button
allows one to edit the layer properties (Fig. 4). The General properties section contains the
name’, thickness, composition®, doping, and mobilities of electrons and holes. One may view
the specified composition profile by using the Preview composition button. The additional

1 The layer name is not used by the code and introduced just for convenience.

2 The composition is required only for layers made of alloys.
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properties are the electron and hole lifetimes related to the point defects, relaxation
parameters (degree of the strain relaxation at the left interface of the layer or the relaxed
layer constant a), and dislocation density. Section ‘Composition fluctuations’ allows the user
to input parameters related to Indium composition fluctuations in InGaN material.

Layer composition and relaxed layer constant a may be specified by using a custom
function, defined by user by a script or by a table which can be imported from a text file. To
use function, one need pick up the function name in the respective drop-down list. One can

edit functions by using " Heterostructure->Functions" menu item.

Layer properties
Layer name :IInGaN-SQW Layer thickness [nm] : |3.5 Electron non-radiative lifetime [s]
Hole non-radiative lifetime [s]
Layer lype : | Alloys 7 Active Dislocation density [cm™-2] 1.000E+09
1egion
| AllnGal — Use composition fluctuation model [/
 Composition : DOS tail parameter Un [e¥] 0.035
Fraction Left point Right point Middle point
lz‘ WN Ig j I I DOS tail parameter Up [e¥] 0.015
[=] InN [0z =l [ DOS tail parameter Usp (eV) 0.025
[=] [GaN [0 =l [ )
Crystal lattice rel
\ | | | : —
{* Degree of relaxation 0
\ | g |
- " Relaxed lattice constant a 'I
— Dopant B
Type Left point Right point Middle point
IE‘ ‘Dunols Jem™-3) ID I I
[-] Acceptors [cm™-3] ID I I
— Mobility -
Type Left point Right point Middle point
[=] Electrans (em™2/75) |1nu | |
[=] Holes (cm™2/¢/5) |1n | |
Composition previerr | AT 3 Cancel

Fig. 4. Layer properties window.

One should mark quantum well layers by the checkbox Active region in the Layer properties
window. The marked quantum wells are indicated in the layer list by purple rows. Each
“purple” region is treated as a separate QW.

Warning: The user is responsible for adequate selection of the quantum wells. If the QW
consists of several layers (for example, triangular or trapezoidal QW) , all the layers should
be marked as QW. Generally, it is recommended not to mark barriers as Active region.
However, one can include them to see the coupling between the QWs. The details are
described in [2] in the section related to the spectrum calculation.

NB: The 'Maximum number of levels in a QW' parameter shows the maximum number of the

wave functions calculated.

A Periodic structure button is introduced to simplify input of multiple quantum well structures.

To create a periodic structure, one should select all layers in one period and use the Periodic
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structure button. The user is prompted to input a number of periods. When periodic structure
is created, the number of periods is shown in the layer list, as seen in Fig. 3 for layers 5 and
6. To delete the periodic structure, one should use the Periodic structure button and input O
or 1 period. The heterostructure may contain several periodic structures. Creating a new

periodic structure overlapping with the existent ones will clear older periodic structures

overlapping with a newly created one.

The Orientation combo box allows the user to specify the heterostructure orientation. Along
with conventional [0001] orientation, a number of nonpolar and semipolar orientations are
supported in the software. Respective inclination angle is shown below the combo box.
Choosing "Custom Inclination Angle" in the combo box allows one to specify a custom

inclination angle in [0,180] range.

To calculate the piezoelectric field, one need to know the strain in the heterostructure.
Unstarined (natural) lattice constants for each layer are calculated from the Vegard law,
while actual strained lattice constant is calculated as follows. By default, first heterostructure
layer is assumed to be relaxed (Relaxed first layer option in the Strain in the first layer
section), i.e. having its natural lattice constants. To specify strain in the first layer, one can
choose ‘Strained first layer’ option and manually specify the lattice constant for the first layer.
Then lattice constant in the next layers is calculated according to the ‘degree of relaxation’
property of the layer. Zero relaxation means that layer has the same lattice constant as
underlying layer, unity relaxation means that layer has its natural unstrained lattice constant.

For details, see respective section on [2].

The bottom area of the Heterostructure window contains a plot representing variation of the
following layer properties throughout the whole heterostructure: doping, mobility, degree of
relaxation, dislocation density, lifetimes of recombination at point defects, and DOS tails.

One can switch between the different variables by choosing the respective tabs.

4.2.2 Import of the heterostructure from a STREEM output file

One can import the heterostructure from an output file of STR STREEM InGaN software by
using Heterostructure->Load Layers From STREEM file menu item. Then the following
procedure will be performs automatically:

» Old set of layers is deleted

» Old set of heterostructure functions is deleted
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» According to the file, tabulated functions describing spatial variation of the layer
composition and relaxed lattice constant a are created for each layer.

» New set of layers is created according to the layer specification in the file. For each
layer, the material composition and relaxation are specified by using the respective
functions. All other parameters contains default data and, generally, to be specified
by the users.

NB After import of the heterostructure, user need specify all the parameters except to that
imported from the file (composition and relaxation). Optionally, one can also add more
layers, delete some layers, correct imported functions, or perform any other corrections of
the input data.

4.2.3 Global Parameters

The Global parameters tab window (Fig. 5) represents the parameters applicable to the
whole simulation and includes four subsections: Physical parameters, Main solver

parameters, and Spectrum solver parameters.

Physical parameters are the temperature and settings for the quantum potential model. One
can switch it on/off as well as specify correction factors. Zero correction factor provide the
same results as without quantum potential model. Temperature factors define the power law
for temperature dependence of the radiative recombination constant and Auger

recombination constants.

Meaning of the solver parameters is described in detail in Sec. 5.6.
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File Heterostructure Material properties Run Export Tools Window Help

ble|am] olw|o] &]|8|ols |
H Global | i ies | Results | Spectrum | Laser | Waveguide | PL parameters

[ Physical and Solver

Physical parameters | |

Temperature (K) 300
Quantum Potential Model Yes
Electron Quantum Potential Correction Factor o7
Hole Quantum Potential Corection Factor 1

Temperature Factor for B 15
Temperature Factor for Cn o
Temperature Factor for Cp 1]

Main solver parameters

Maximum number of iterations 500
Basic mesh step for thick layers (nm] 2
Basic mesh step for thin layers [nm) 01
Thin layers are lower than [nm] 5
Boundary mesh step [nm] om
Mesh refinement factor 2

Spectrum solver parameters

Mesh step [nm] 0.05
Wavefunction damping in a barrier 100
Maximum number of levels in a QW 100
Minimum energy level [eV] 0.0z
Spectrum broadening (eV) 0.005

Fig. 5. Global parameters tab window.

4.2.4 Material Properties

The Material properties tab window shows the loaded materials properties in the read-only
mode. The Material properties menu allows the user to export the data from the current
project to the separate material database file or overload the existent data from other
SILENSe project or material database file (import of the material properties). The import can
be done only if the new material database contains valid properties for all the materials used
in the heterostructure.
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Fig. 6. Material properties tab window.

425 Results

The Results tab window includes six plots designed in order to clearly present the simulation

results: Band diagram, Potential & Electric field, Carrier concentration, Recombination, and

Current. Available manipulations with graphs are described in detail in Sec. 4.3.4.
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Fig. 7. Results tab window.

4.2.6 Spectrum

The Spectrum tab window is divided into two tabs: Band diagram and wave functions and
Spectrum. The former tab contains a plot with the band diagram and carrier wave functions
as well as a list of the quantum wells. The quantum wells are humbered subsequently and
their indices are listed in the subsection. The respective quantum well can be chosen by the
mouse click and automatically marked by the cyan vertical stripe in the graph window. The
movement from one well to another can be proceed either by direct choice of the well

number by mouse or by the use of keyboard keys “-", “<”, “1”, and “1".

The energy levels in the chosen quantum well are listed in the right subsection. The user can
turn on/off the wave functions in the selected quantum well by the checkboxes near the
energy values. The total number of the energy levels in the selected quantum well is given in
the brackets after the carrier type.

i
File Heterostructure Material properties Run Export Tooks Window Help
ERERDEEEE=
H | Global | i ies | Results Spectium | Laser Wavequi
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Fig. 8. Band diagram and wave functions tab window.

The Spectrum tab window shows the spontaneous emission and gain spectra of individual

guantum wells, as well as the total spectra. The lines can be switched on/off by the
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respective checkboxes in the right part of the window. The user can switch between the
guant energy and the wavelength by the respective vertical tab.
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Fig. 9. Spectrum tab window.

4.2.7 Laser parameters tab window

The Laser Parameters tab window contains global parameters related to the analysis of
laser diodes. One group of parameters controls the calculation of the threshold
characteristics. The user should specify the stripe geometry, reflectivity of the output and
back mirrors, the polarization and index of the waveguide mode for which the analysis
should be done. The Additional loss parameter allows one to specify an additional optical
loss of any source. The last two parameters control the iterative adjustment of the current
density converted into the stimulated recombination rate. The Initial step parameter means
that the first initial guess will be the given fraction of the current density converted into the
radiative recombination. The Gain Fitting Accuracy specifies the accuracy of fitting the
condition that the total gain equals to the total losses. Use Imported Gain Data flag specifies
whether user wants to replace calculation of the gain by a user-defined function. If this
parameters is not "No", Peak Gain vs Current Density Function and Peak Gain Wavelength
vs Current Density Function are the names of the functions for the maximum gain and

respective wavelength. The button Edit Gain Import Functions enables editing these
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functions. Use Absorption From Material Data flag specifies whether the free-carrier

absorption coefficient to be replaced by the absorption coefficient specified in the material

properties data.

The other group of parameters controls computation of the waveguide modes. Since the
electric/magnetic field distribution typically is much wider than the active region, for correct
description of the waveguide one need to describe the thick n-contact layer and the
substrate. The n-contact layer is assumed to be of the same composition as the first layer in
the Heterostructure tab window, so one need only input its actual thickness. As for the
substrate, the user should select the material from the drop-down list containing all the
materials described in the project. The substrate composition field is enabled for alloy
materials only. The Substrate thickness in computations parameter specifies the part of the
substrate included in the waveguide computations. It should just provide an exponential
decay of the field distribution. Do not input here the actual substrate thickness! The Mesh

step parameter shows the mesh step used in waveguide computations.

il
File Heterostructure Material properties Run Export Tools Window Help
o= p|w| o] &o|o|e
| Global | Materi jes | Results | Spectrum [ Laser paraneters | Waveguide | PL parameters |
Laser
Laser parameters | Values |
Cavity length [micron) 500
Stiipe width [micron] 15
Back mirror reflectivity 018
Output mirror reflectivity 018
Additional loss (1/cm) 1
Polarization TE
Mode index 2
Initial Step (in units of jrad) 005
Gain Fitting Accuracy (1/cm) 01
Use Imported Gain Data Mo Edit Gain Import Functions
Peak Gain vs Current Density Function
Peak Gain Wavelength vs Current D ensity Function
Use Absorption From Material D ata Mo
Waveguide solver parameters Values
Actual first layer thickness (nm) 2000
hick in ions (nm) 1000

Substrate material AllnGsN
Substrate composition {004:0.036;}
Mesh step [nm] [1k3)

Fig. 10. Laser parameters tab window.
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4.2.8 Waveguide tab window

The Waveguide tab window consists of two tabs: Refractive index waveguide modes and

Far field. The former tab contains plot of the refractive index for ordinary (magenta line) and

extraordinary (cyan line) waves (Fig. 11). The distribution of the electric and magnetic field

intensity for TE and TM waveguide modes is shown by red and blue lines, respectively. The

user can switch them on/off by the respective checkboxes in the right part of the window.

The number appearing after the mode index is the effective refractive index B/k. The region

of negative position represents the buffer layer and a part of the substrate.

The Far field tab shows the distribution of the far field intensity.

SiLENSe 4.00 Laser Edition

Eile Heterostruckure  Material properties  Run  Export Tools Window Help
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Fig. 11. Refractive index waveguide modes tab window.
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Fig. 12. Far field tab window.

4.2.9 PL parameters tab window

The PL parameters tab window contains global parameters related to PL simulations. First

group describes the excitation and second group includes PL solver parameters.

SiLENSe 5.4 Laser Edition : C:\Program Files (x86)\STR IP Holding\SiLENSe 5.4 Laser Edition\Examples\LaserDiode_Bluesls =0 ll
File Heterostructure Material properties  Run Export Tools Window Help
| =@ olw| o] 2E |l
; | Global | i ies | Results | § | Laser Waveguide | PL paiameter I
Laser
Photolumenescence parameters Values

Excitation wavelength (nm) 380
Excitation direction From top [p-side]
Reflection from boundaries Manually specify i=flection
Top [p-side) mirror reflectivity 02
Bottom (n-side) mirror reflectivity 01
Immersion medium refractive index

Photolumenescence solver parameters Values
G - R relative accuracy 1.000E-08
Initial concentration step [1/cm™2) 1.000E+12
Concentration fitting accuracy 1.000E-08

Fig. 13. PL parameters tab window.
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4.3 Other Windows

4.3.1 LED Results

The Window | LED Results menu item opens the LED Results window with the table of the
results which were stored in the project file or obtained during the current session. The table
includes the following data: bias, current density (J), radiative (J.a4) , total non-radiative
(Jnraa), Shockley-Read-Hall (Jsgrn), and Auger (Jauger) fractions of the current density, injected
electron (J,) and hole (J,) current densities, minority carrier current densities (J, rign: and J,
er), internal quantum efficiency (IQE), injection efficiency, non-ideality factor (m), peak
emission wavelength (Peak WL), and sheet carrier concentrations in the active region (n*°

ZD).

and p

The menu bar of the LED Results window enables the user to manage the result computed.

NB All the menu items are duplicated by the respective buttons in the toolbar.

The Edit menu allows deleting selected results as well as select/unselect all the results. The
user can load a result in the Results tab window by using Show | Current result menu item or
just by double-click on the respective string in the table. To plot the current-voltage
characteristics and internal quantum efficiency as a function of bias one should use the

Show | I-V characteristic menu item. Only selected results will be evaluated.

The item Run | Wave functions and spectrum enables one to calculate the carrier wave
functions and emission spectrum for the current result (marked by the gray color). To
calculate the peak emission wavelength for all results, one can use Run | Update Peak

Wavelength menu item.

The Export menu allows the user to export simulation result into a text file. First two items
store the current result and |-V characteristic, respectively. Export | All Results in Single File
menu item allows to export all the results for band diagrams, carrier concentration, and so on

into a single text file for further analysis. The output formats are described in detail in Sec. 5.

SiLENSe User Manual 26 of 39




[ ]
T x|
Edit Show Run Export
SIEIREAE] [ |
N[ Biss J Jrad JSAH | JAuger Jn Jp Jnight | Jpleft I0E I eff ™ 2D
1 2.5 0.0003 0.0001 0.0002 aooz 0.0003 0003 0.9944 47¢ g | 2891E+11 [ 2019E+03
2 25 0045 00024 00020 GEEIEDS  OOMS  00M5  A79E08 37WEDR 0567 09%7 14801 ESE3E 1 1.810ED
3 27 0004 0OEm O 0TES 00014 O0S04 00804 21SSE07 Z1SSE07  OESEE 09980 15979 4777793 993E41 1398EN
4 2B 043E 03T 00924 00274 0433 0433 BEEZEDG GTENE0R 0723  099E 17973 475377 1542 5IGE
5 28 3478 24301 10418 05638 Q4781 34719 34713 B20SE05 BSSE05 06983 09990 18580 4714210 257EW1Z 130342
6 3 2194 174409 117566 38957 78563 291965 291964 000D 001 05973 09992 1BIGE  ABRZZT AOZEEL2 28632
7 34 3161.0050 9223685 2191.9070 1873147 20045320 3161.00 3114330 466744 0.0554 0.2908 0.9793 33029 4450241 1170E+13 1.149E413
| % Close | ‘

Fig. 14. LED Results window.

One can export simulation results to the SpeCLED module for further 3D analysis of current
spreading and temperature distribution in the LED chip. One should check simulation results
in the LED Results window and use the Export | Export to SpeCLED menu item. An Export
to SpeCLED modal window appears with list of selected voltages. Prior to export one should
start computation of emission spectrum by the Run spectra button. The status of spectra
computation is displayed in the table. After the spectrum computation one can finish export

by the Export button.

Warning: The data for SpeCLED module should cover the whole IV range. The voltage step
should be not greater than 0.1 V for voltages higher than a turn-off voltage. For a minor
current under low biases a larger step of ~0.5 V is acceptable.

4.3.2 PL Results

The Window->PL Results menu item opens PL Results window representing a table with all
completed PL simulations like LED Results window shows results for current injection mode.
The table includes the following data: bias, excitation power density (ExcPower), total
recombination current density (J), radiative (J..q) , total non-radiative (Jnraq), Shockley-Read-
Hall (Jsre), and Auger (Jauger) fractions of the current density, internal quantum efficiency
(IQE QW), and peak emission wavelength (Peak WL).

All other functionality of PL Results window is similar to that of LED Results window.
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Fig. 15. PL Results window.

4.3.3 1-V Characteristic

The Show | |-V characteristic menu item in the LED Results window opens an |-V
characteristic modal window with three plots. The former two plots represent the current
density as a function of the bias and the internal quantum efficiency variation with the current
density, respectively. The last plot is introduced to rely the calculated current density with
experimentally observed I-V characteristics by qualitative accounting for the series and
contact resistance. The user is prompted to specify the LED area, the series resistance, and
the contact resistance for the n- and p-contacts. The current and voltage are calculated as
described in Sec.7 of [2]. The plot is updated when one uses the Apply button.

- 1-¥ characteristic [BE=]

(T curve | Intemal quantum eficisncy | 1 curve with serial esitancs

1E-024
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1E-044
1E-054
1E-064
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1E104

Current denstty (Aiem"2)

.0 2,01 3
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% Close

Fig. 16. |-V characteristics modal window.
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4.3.4 Overlap Integrals

This window shows the squared overlap integrals between each pair of the electron and hole

wave functions. The data for different quantum wells are shown in different tabs.

=10l x|
owi Ow2 |ow3s| owd |
Eloctions 1 | Eloctons 2 | Elections 3 | Elections 4|
Haavy holes 1 01991 02458 02743 10,0985
Heavy holes 2 02838 00244 00013 0.0386
Heavy holes 3 oisz | ool oo 00021
Heavy holes 4 wims oone 00519 00335
Heavy holes 5 00573 00161 0031 0.0085
Light holes 1 0191 02458 02743 10,0886
Light holes 2 02837 00244 00013 00356
Light holes 3 01528 0021 00024 00021
Light holes 4 01318 0013 00518 00335
Light holes 5 00574 00161 00321 0.0085
Split-off holes 1 04174 01818 01797 00842
Split-off holes 2 02557 001 0.0084 e

Fig. 17. Overlap Integrals window.

4.3.5 Detailed Spectrum

This window allows inspect fine details of the emission spectrum. Tree in the left part of the
window shows total emission spectra and total contribution of each of the valence band
followed by contribution of individual QWs. Contribution of each QW is also divide into
contribution of three subbands and even individual transitions. Values after the colon
indicate relative contribution of the item in the total emission spectrum. If the selected item
represents parameters of an individual transition, the below table shows its following
parameters: relative contribution to the total spectrum, squared overlap integral, occupancy
factors of the electron and hole energy levels (at zero energy of the lateral motion), and a
product of the squared integral and occupancy factors.

One can visualize the emission spectrum of an item by using button with right arrow or
double click on the item. Then the item will appear in the check list in the center of the
window. Check boxes allow show and hide individual lines. To remove an item from the
check list, use the button with left arrow. Button with double left arrow removes all items from
the check list. Colors of lines resemble colors of the carrier wave functions. Blue lines show
total emission spectrum and total contributions of an individual QWs (all subbands together),
while red, green, and orange lines shows contributions of heavy, light, and split-off holes,
respectively.

Save button allows to save these data in ASCII format (the same effect has ‘Export-

>Detailed Spectrum’ menu item in the main window).
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Relative Intensity 0.0878 T T H T > T T T T
_ 3 31 32 33 34 35 36 37 35
Squared overlap integral, M 0.4343 Energy (21
Electron accopancy factor, fe 0.9051
Hole accopancy factor, fh 0.1154
Product fe * fh = M 0.0454 Help H save % Closo |

Fig. 18. Detailed Spectrum window.

4.3.6 Optical Confinement Factors

This window shows the optical confinement factors for each mode and each quantum well.
The column Total shows the sum over the quantum wells. The user can sort modes using
the following Sort By menu items:
» Mode Index (First TE) — modes are sorted by their index, TE modes go first.
» Mode Index (First TM) — modes are sorted by their index, TM modes go first.
» Value — the modes are sorted by the value of total optical confinement factor in the
descending order. This option allows reveal the mode which is most favorable for
laser generation, i.e. having larger optical gain and, therefore, lower threshold

current.
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4.3.7

x|
Sort By
Mode | Total | ow1 [ ow2 | ows [ ows |ﬂ
TE1 | 000m |3197E05; GMI0E0S 278905 2539605

TE2 1.792E-05 | 4.899E-06 4.E58E-0E  4.357E-06  4.005E-0E

TE3 BE7ZE05 | 1.798E-05 1.727E-05 1.632E-05 1.515E-05

TE 4 00004 | 9922E-05 9.7IEEOS 9351E05  B.B40E-05

TES 00170 0.0043 0.0043 0.0043 0.0042

TEB 7.513E-07 | 4.881E-0F 1.175E-07 1.478E-03 1.443E-07

TE7 00176 0.0045 0.0045 0.0044 0.0042

TES 0.0d10 0.0002 0.0002 0.0003 0.0003

TEQ 00004 | 6635E-05 B.301ED5 9942605 0.0001

TE 10 0.0003 0.0002  9.835E-05 4372605 1.043E-05

TE 11 0.0022 0.0008 0.0008 0.0005 0.0004

TE 12 0.0049 0.00m 0.0012 0.0013 0003

TE 13 0.0017 0.0003 0.0004 0.0005 0.0008

TE 14 0.0004 0.0002 0.0001 E4Z7E-05  2.244E-05

TE 15 0.0055 0.0016 0.0015 0.0012 0.0011

TE 16 0.0029 0.0008 0.0007 0.0002 0.0008 |

Fig. 19. Optical Confinement Factors window.

Laser Characteristics

The Laser Characteristics window presents the laser characteristics. The first tab includes a

table with the following columns:

>

YV V V V V V V V V V

Bias (V)

Output optical power (W)

Current (A)

Current density (A/cm?)

Radiative current density (A/cm?)

Stimulated current density (A/cm?)

Optical gain (1/cm)

Total optical loss (1/cm)

Optical loss because of the free carrier absorption in the quantum wells (1/cm)
Optical loss because of the free carrier absorption outside the quantum wells (1/cm)

Wavelength of the gain spectrum maximum (nm)

SiLENSe User Manual 31 of 39



Laser Characts

|

Export
Table | Power | Optical Gain/Loss | Wavelengh |
Bias | Power | Current | i j rad j stim | Gain Loss Total | Loss AR |Loss Passive| Wavelength | a
] [mWw) [mA) aem™2) | Alem2) | [Alemn2) [1/cm) [1/cm) {1/cm) [1/cm) [nm)
161 0 282.01 141,005 125612 0 22900 10,1461 00615 0.0375 13,008
182 i 3158 157.9 140 461 0 36716 101497 00643 0.0376 g1 412
163 0 351,832 175,916 156194 0 51655 101532 0.0683 0.0377 809,822
164 0 390.026 195,013 172.807 0 6.7191 10,1569 00718 0.0380 808,765
166 i 430502 215 251 190,295 0 8.2953 101608 00753 00383 808 238
166 0 473,745 236,873 20891 0 9.9245 10,1646 00788 0.0386 £07.186
1,661 0 478.234 239117 210835 0 10.0895 10,1650 0.0791 0.0386 807,166
1662 i 482,746 241373 212769 0 10254 101654 0073 0.03687 807.186
1.663 13.9247 435,43 244,215 215.765 45328 101672 10,1652 00733 0.0387 £07.186
1,664 23.0684 493732 245,865 218.404 75093 101672 10,1652 00733 0.0387 807,166
1,665 335794 439145 249573 221151 10,9308 10143 101651 00733 0.03687 807.186
1,666 40,7436 504.322 252,161 223,651 13,2629 101647 10,1652 00733 0.0387 £07.186
1.667 49,9467 509.634 254,817 226,301 16,2587 10.1648 10,1653 00793 0.0387 £07.186
1,660 531572 514,988 257 494 228367 19,2563 101653 101653 00733 0.03687 807.186
1669 £8.3483 520,336 260168 231 631 22243 10166 101653 00734 0.0387 807,186
167 78.8564 525.804 262,902 234395 25,6694 101433 10,1652 00793 0.0388 £07.186
168 169 9264 579,904 209 952 261.232 55 3145 104701 101655 00734 0.0389 807.186
164 263 B4ED 635,238 317,613 286,702 856223 101873 101657 00735 0.0380 807,186
17 3583487 £91.662 345,831 16657 11665 10.2309 10,1659 0.07% 0.0391 £07.186
18 14140280 1318830 856 413 825,375 460 295 104781 101682 00604 0.0406 807.186
19 2671 650 2041.00 1020 50 973977 863 683 101541 101681 00788 0.0421 807,186

H

X Close

Fig. 20a. Laser Characteristics window : Table.

The second tab shows the power-current characteristics as well as the threshold current and the

differential quantum efficiency.

Export

Table Power |UptlcaIGa\n/Loss| Wavelengthl

1E+04
9.8E+03
936403
8.0E+03
836403
7.8E+03]
7.3E+03]

F BE-+03]
i 36403
o5, 8E+03]
§5 3E-+03
4 BE-+D3
£ 3E+403]
&3.8E+03]
3 36403

2 BE+03

2 36403
1.8E+03]

1 3E403]

7 9E+H12

2 9E+12

77412

1774.12

27741

FE XE
Current (mA)

477412

577412

E774

Parameter
Diff. eff

ncy (%)
Diff. efficiency (W/fA)
Threshold (mA)

Threshold (Afcm™2)

24154
2515.3260
2096.1050

Fig. 20b. Laser Characteristics window : Power-Current characteristics.

The third tab shows variation of the optical gain and loss with the current density.
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Laser Characteristics i [=] 3]

Export
Table | Fower Optical Gain/Loss IWave\englhl

4 2E+11 |~Wariables [1/cm)

VlGain
AE+014 (v Total losses
3.8EHI1 Free carriers in QWs
3EE+01 ] Other free carriers

3 4E411
3 2E401
£ 3E0
22.8E+01
@2 BE+01
§2.4E401
= 2.2E+011
E 2E+01]
' 1 BEH1
ES
= 1 BE+11]
2
£ 14E+01
© 1.2E+01]
9 7E-0
7 7FEHI0
5. 7FE-00
3.7E-00
1.7E+D

L - . . ” : : i i : : ! Farameter |Va|ue
14510 64510 1145.101645.102145.102645.10 314510364510 4145.10 4645.10 5145.105645 || Radiative loss (1/cm) 14.2900

Current density (A‘em~2) Additional loss (1/cm) 0.2

X Close

Fig. 20c. Laser Characteristics window : Optical Gain and Loss.

The fourth tab shows variation of the gain spectrum maximum with the current density.

Laser Characteristics I =] B3]
Export
Table | PDWEI' Optical GaindLoss  Wavelength |
460
458
456
4544
4529
4504
148
4464
4444
4425
4404
435
4364
4344
4325
4304
4289
4264
4244

Emission wavelength (nm)

077 177 277 377
Current density (A‘cm”2)

X Close

Fig. 20d. Laser Characteristics window : Wavelength.

4.4 Exploring Plots

All the graphs in SiLENSe support the following operations:
» Zoom in: select the region of interest from the upper left to the right down keeping

the left mouse button pressed. The zoomed region will appear in the plot window.
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» Zoom out: select any region in the plot area from the right down to the left upper
keeping the left mouse button pressed. This action returns a plot to the full-size
mode.
» Scrolling: drug the plot inside the plot area keeping the right mouse button pressed.
Then the adjacent region of the plot will be displayed.

NB Save current chart menu item allows the user to save current chart as a graphic file.

5 Output Files

The simulation results can be stored either as plain text data files or as ASCII TecPlot® files
(*. pl t), which allows visualization within the graphic software package Tecplot®. Anyway,

the data are stored in columns separated by tab and the difference is in the headers only.

5.1 Band Diagram, Carrier Concentrations, Recombination Rate etc.

The Export | Current result menu item in the LED Results window enables one to export the
results of main drift-diffusion solver. The following variables are stored in columns separated
by tab:

» Position (nm)

» Conduction band, valence band, qguantum potential for electrons and holes, electron
Fermi level, hole Fermi level (eV)
Electric potential (V) and electric field (MV/cm)
Electron and hole current densities (A/lcm?)

Concentration of electrons, holes, ionized donors and acceptors (cm™)

Y V VYV VY

Radiative recombination, total non-radiative recombination, Shockley-Read-Hall
recombination, Auger recombination (cm® s*), and generation rate (for PL

computations)

Y

Absorption coefficient (for PL computations)

Y

Spontaneous, piezoelectric, and total polarization (C/m?)

Y

Four strain components: €,,, £,,, &,,and €,

Non-radiative carrier lifetimes due to dislocations and point defects
The Export | All Results in Single File menu item provides export of the same data for all the
computed results. In this case, a column containing the p-n junction bias is inserted into first

position.
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5.2 |-V Characteristics

The Export I-V characteristics button in the LED Results window enables one to export the |-

V characteristic and related values. The following variables are stored in columns separated

by tab:
» Bias (V)
> Current density (A/cm?)
» Internal quantum efficiency
» Injection efficiency
» Peak emission wavelength (nm)
» Non-ideality factor
» Voltage (V)
» Current (A)
> Radiative current density (A/cm?)
> Non-radiative current density (A/cm?)
> Current density of Shockley-Read-Hall recombination (A/cm?)
> Current density of Auger recombination (A/cm?)
> Injected electron current density (A/cm?)
> Injected hole current density (A/cm?)
> Electron current density at p-type boundary (A/cm?)
> Hole current density at n-type boundary (A/cm?)
> Sheet electron concentration in the active region (cm™)
> Sheet hole concentration in the active region (cm™)

5.3 Carrier Wave Functions

The Export | Carrier Wave Functions menu item enables one to export the carrier wave
functions. The output file contains the following variables stored in columns separated by
tab:

» Position (nm)

» Conduction band, valence band, electron Fermi level, hole Fermi level (eV)

» QW indicator which equals to 1 if the point belongs to one of QWs and 0 otherwise

> Carrier wave functions (nm*?)

Wave functions are named as follows:
QMEQW i ndex><carrier type><level index>,
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where letters EE, HH, LH, and SH denotes electrons, heavy holes, light holes, and split-off
holes, respectively.

5.4 Emission Spectra

The Export | Emission Spectra menu item enables one to export the emission spectra. The
output file contains the following variables stored in columns separated by tab:

» Energy (eV)

> ETotal (cm®s™ eV™) — total emission intensity

> EQW1 (cm™?s™ eV™) — emission intensity from the 1-st QW

> EQW?2 (cm™?s™ eV™) — emission intensity from the 2-nd QW

> EQWN (cm? s eV™') — emission intensity from the last QW

The following data are the same intensities normalized to the wavelength
» Wavelength (nm)
> WrTotal (cm™?s™ nm™) — total emission intensity
> WQW1 (cm? s nm™) — emission intensity from the 1-st QW
> WQW2 (cm? s™ nm™) — emission intensity from the 2-nd QW
>
>

WQWN (cm™? s™ nm™) — emission intensity from the last QW

Warning: One should plot the data form the first group vs the energy, and from the second
group vs the wavelength in order to keep the right normalization of the intensity to the total
recombination rate!

5.5 Gain Spectra

The Export | Gain Spectra menu item enables one to export the gain spectra. The output file
contains the following variables stored in columns separated by tab:

» Energy (eV)

> ETotal (cm™) — sum of the following columns

> EQW1 (cm™) — gain in the 1-st QW

> EQW2 (cm?s™eV?) —gain in the 2-nd QW

> EQWN (cm?s™eV?) —gain in the last QW
» Wavelength (nm)
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5.6 Overlap Integrals

The Export | Overlap integral menu item enables one to export the overlap integrals. The
output is a text file. The data are arranged similarly to their appearance in the Overlap
Integrals window (Sec. 4.3.4).

5.7 Waveguide Modes

The Export | Waveguide Modes menu item enables one to export the gain spectra. The
output file contains the following variables stored in columns separated by tab:
» Position (nm)
Refractive index for ordinary wave
Refractive index for ordinary wave modified — see details in [2].
Refractive index for extraordinary wave modified
Refractive index for extraordinary wave modified — see details in [2].
FieldTE1 (cm™) — squared electric field for the 1-st TE mode
FieldTE2 (cm™) — squared electric field for the 2-nd TE mode

V V. V VYV VYV V

Y

A\

FieldTEN (cm™) — squared electric field for the last TE mode
FieldTM1 (cm™) — squared electric field for the 1-st TM mode
> FieldTM2 (cm™) — squared electric field for the 2-nd TM mode
) S

> FieldTMN (cm™) — squared electric field for the last TM mode

Y

5.8 Laser Characteristics

The Export | Laser Characteristics menu item enables one to export the laser characteristics.
The data are arranged similarly to their appearance in the Table tab of the Laser
Characteristics window (Sec. 4.3.7).

6 Solver Parameters

The section describes the solver parameters in the Global parameters tab window.

6.1 Main Solver Parameters

The grid is generated automatically by the procedure described below. First, the basic mesh
step is chosen for each layer, which is equal to Basic mesh step for thick layers and Basic

mesh step for thin layers, for layers with thickness higher and lower than Thin layers are
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lower than parameter, respectively. The grid step in the central part of the layer equals to
this basic mesh step. The mesh step adjacent to the layer boundaries equals to Boundary

mesh step. Then the mesh step is increased by the factor of Mesh refinement factor until it
reaches the basic mesh step.

The computations are terminated if the iteration number exceeds the value of the Maximum

number of iterations parameter.

6.2 Spectrum Solver Parameters

The spectrum solver generates a separate uniform mesh for each quantum well to solve the
Schrddinger equation. The user should specify the Mesh step in the respective text field. The
recommended mesh step is about 0.05-0.2 nm. Effective LAPACK computational routines [3]

are used to solve the eigenvalue problem.

The Minimum energy level and Wavefunction damping in a barrier parameters are used for
determination of the computational domain boundaries for each quantum well, as described
in Sec. 8.2 of [2]. They are rarely needed to be modified. Generally, quantum wells with the
barrier heights smaller than the value of the former parameter are ignored in the spectrum
calculation. The last parameter determines the minimum damping of the wave function at the
domain boundaries. The higher this parameter, the wider barrier regions are included in the

domain.

The Maximum number of levels in a QW parameter is introduced to limit the maximum
amount of the heap memory and computation time needed for the solution of the
Schrddinger equation. If there are more levels exists in the quantum well, only first several

levels will be calculated according to the maximum number.

The Spectrum broadening parameter determines the width y used to calculate the spectrum

broadening as discussed in Sec. 8 of [2].

6.3 PL Solver Parameters

The PL solver parameters are shown in the bottom section of the PL parameters tab
window. G - R relative accuracy is the relative accuracy for solution of the steady state
condition, Concentration fitting accuracy is the relative accuracy for the adjusting of the

Fermi level to get desired additional non-equilibrium 2D carrier concentration, and Initial
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concentration step is the value of additional 2D carrier concentration at first step of solution
steady-state condition. For more details please see Sec. 12 of [2].

7 References

[1] Properties Editor Manual.

[2] SILENSe Physics Summary.

[3] Anderson, E. and Bai, Z. and Bischof, C. and Blackford, S. and Demmel, J. and
Dongarra, J. and Du Croz, J. and Greenbaum, A. and Hammarling, S. and McKenney, A.
and Sorensen, D., LAPACK User's Guide, 3 ed., Society for Industrial and Applied
Mathematics, PA, 1999.

SiLENSe User Manual 39 of 39



